LENESAS

Release Note

RZ/T2H Group

Encoder I/F HIPERFACE DSL Safety sample program

Summary

This document describes the RZ/T2H Encoder I/F HIPERFACE DSL® Safety sample program package.

For HIPERFACE DSL® communication protocol specifications and encoder specifications, contact SICK AG.

Functionality Checked Device
RZ/T2H Evaluation Board (RTKORZT2HXXXXXXXXX)
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RZ/T2H Group Encoder I/F HIPERFACE DSL Safety sample program

1. Package Contents
This package contains the following contents.

The RZ/T2H encoder interface supports up to 16 axes, but the sample program uses only 1 axis of them. If
you use with 2 axes or more simultaneously, modify the sample program to support required axes.

1.1 Software
e Source Code

No. Name Version number
1 RZ/T2H HIPERFACE DSL Safety sample program (CR52 ver. *) 20
2 RZ/T2H HIPERFACE DSL Safety sample program (CA55 ver. *) 2.0

Note: This sample program has a CR52 version that runs on the CPU core Cortex-R52 and a CA55 version
that runs on the CPU core Cortex-A55. CR52 ver. and CA55 ver. are descriptions of the respective
version.

1.2 Document

No. Document name Version File name
1 RZ/T2H Group Encoder I/F 2.01 (j) r11an0810jj0201-rzt2h.pdf
HIPERFACE DSL Safety sample (e) r11an0810ej0201-rzt2h.pdf (this document)
program Release Note
2 RZ/T2H Group HIPERFACE DSL 2.00 (j) r11an0809jj0200-rzt2h-hfdsl-safety.pdf
Safety Sample Program (e) r11an0809ej0200-rzt2h-hfdsl-safety.pdf
Application Note
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2. File Structure

The file structure and contents of this package are detailed below.
Top
F— r11an0810jj0201-rzt2h.pdf
F— r11an0810ej0201-rzt2h.pdf
L— workspace
— Software

| — iccarm

| |  }— RZ_T2H_CR52_hfdsl.zip - RZIT2H HIPERFACE DSL Safety

| | | Sample program CR52 ver. (IAR) set

| |  L— RZ_T2H_CAS55_hfdsl.zip

| | — RZ_T2H_CA55 0 _hfdsl :RZ/T2H HIPERFACE DSL Safety

| | | Sample program CA55 ver. (IAR) set

| | L— RZT_2H_CR52_0_primary

| | : CPU_CTRL register setting program (IAR)
\ — gec

| — RZ_T2H_CR52_hfdsl.zip : RZ/T2H HIPERFACE DSL Safety

| | Sample program CR52 ver. (e studio) set
| L— RZ_T2H_CA55_hfdsl.zip

| — RZ_T2H_CA55 0 _hfdsl : RZ/T2H HIPERFACE DSL Safety

| \ Sample program CA55 ver. (e2 studio) set
| L— RZ_T2H_CR52_0 primary

| : CPU_CTRL register setting program (e? studio)

L— Documents
— r11an0809jj0200-rzt2h-hfdsl-safety.pdf
L— r11an0809ej0200-rzt2h-hfdsl-safety.pdf

The file structure of the RZ_T2H CR52_hfdsl.zip and the RZ_T2H_CA55 0_hfdsl folder is shown below.

Top folder
— configuration.xml : FSP Configuration data
— ( Environment File Depending on Build Tool )
L— src
F— hal_entry.c : HIPERFACE DSL Safety sample program
— hfdsl_main.c : HIPERFACE DSL Safety sample program
— siochar.c : SCI_UART sample program
— siorw.c : SCI_UART sample program
— sio_char.h : SCI_UART sample program
L— drv
L— hfdsl
— iodefine_hfdsl.h : HFDSL register definition file
F— r_hfdsl_rzt2.c : HFDSL driver file
F— r_hfdsl_rzt2_config.h : HFDSL driver file
F— r_hfdsl_rzt2_dat.h : HFDSL driver file
L— r_hfdsl_rzt2_if.h : HFDSL driver file
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The file structure of the RZ_T2H_CR52_0_primary folder is shown below.

Top folder
— configuration.xml : FSP Configuration data
— ( Environment File Depending on Build Tool )
L— src
L— hal_entry.c : CA55 start-up program
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3. About HIPERFACE DSL Safety Sample Program

This section contains information necessary to use the complete set of HIPERFACE DSL Safety.
3.1 Software Information

3.1.1 Base OS

This sample program is OS-independent.

3.1.2 Memory Size

Memory size used by this sample program and HFDSL driver is shown in the following table. This table does
not include the memory size used by Flexible Software Package or C language libraries of the compiler.

(1) CR52 ver.

ltems Memory Size

EWARM e? studio

[kBytes] [kBytes]
HFDSL driver Code 5.0 3.8
Data (with initial value) 0.0 0.0
Data (without initial value) 0.8 0.8
Constant Data 0.4 0.4
Sample program Code 2.7 3.1
Data (with initial value) 0.0 0.0
Data (without initial value) 04 04
Constant Data 1.2 1.2

(2) CADS55 ver.
ltems Memory Size

EWARM e? studio

[kBytes] [kBytes]
HFDSL driver Code 7.3 6.6
Data (with initial value) 0.0 0.0
Data (without initial value) 1.1 1.2
Constant Data 0.7 0.8
Sample program Code 44 53
Data (with initial value) 0.1 0.0
Data (without initial value) 0.4 0.4
Constant Data 1.3 1.3
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Encoder I/F HIPERFACE DSL Safety sample program

3.2 Hardware Information

3.2.1
RzZ/T2H

Device

3.2.2 Target Board
(1) Board Name

RZ/T2H Evaluation Board (RTKORZT2HXXXXXXXXX)

(2) Setting of the Target Board
The target board configuration is as follows.
SW1-6: OFF
SW2-1: ON, SW2-2: OFF
SW2-7: OFF
SW2-8: OFF

SW14-1: ON, SW14-2: OFF, SW14-3: ON, SW14-6: OFF (Set xSPI1 boot mode)

CN39: Short between 2-3 pins (Set VDD1833 210 3.3 V)
CN40: Short between 2-3 pins (Set VDD1833_3 to 3.3 V)
CN78: Short between 1-2 pins, Open between 3-4 pins, and between 5-6 pins (Set VDD1833_6 to 3.3 V)

Note: To use target board RTKO9RZT2HOCW1000BJ with connecting RS-485 board, power on/off by
plugging and unplugging to the power-supply connector CN47 with keeping the slide switch SW16 on.

(3) Used Pins of the Target Board

The correspondence between the pin used as the encoder I/F and the pin header of the target board is as

follows.
Channel Port Name Pin Header | Input/Output Voltage Description
Domain
HFDSLO ENCIFDIOO (dsl_in) CN2 #9 Input VDD33 Data input
ENCIFDOOQO (dsl_out) CN2 #7 Output VDD33 Data output
ENCIFOEOQO (dsl_en) CN2 #5 Output VDD33 Drive/receive control
HFDSLA1 ENCIFDIO1 (dsl_in) CN2 #8 Input VDD1833_3 | Data input
ENCIFDOO1 (dsl_out) CN2 #6 Output VDD1833 3 | Data output
ENCIFOEO1 (dsl_en) CN2 #4 Output VDD1833_3 | Drive/receive control
HFDSL2 ENCIFDIOZ2 (dsl_in) CN2 #17 Input VDD33 Data input
ENCIFDOO02 (dsl_out) CN2 #15 Output VDD33 Data output
ENCIFOEOQ2 (dsl_en) CN2 #13 Output VDD33 Drive/receive control
HFDSL3 ENCIFDIO3 (dsl_in) CN2 #18 Input VDD33 Data input
ENCIFDOOQ3 (dsl_out) CN2 #16 Output VDD33 Data output
ENCIFOEOQS3 (dsl_en) CN2 #14 Output VDD33 Drive/receive control
HFDSL4 ENCIFDIO4(dsl_in) CN2 #27 Input VDD1833_5 | Data input
ENCIFDOO04 (dsl_out) CN2 #25 Output VDD1833_5 | Data output
ENCIFOEO4 (dsl_en) CN2 #23 Output VDD33 Drive/receive control
HFDSL5 ENCIFDIO5 (dsl_in) CN2 #26 Input VDD1833_6 | Data input
ENCIFDOO05 (dsl_out) CN2 #24 Output VDD1833 6 | Data output
ENCIFOEOQS (dsl_en) CN2 #22 Output VDD1833_6 | Drive/receive control
HFDSL6 ENCIFDIO6 (dsl_in) CN3 #9 Input VDD1833_3 | Data input
ENCIFDOO06 (dsl_out) CN3 #7 Output VDD1833_3 | Data output
ENCIFOEOQ6 (dsl_en) CN3 #5 Output VDD1833_3 | Drive/receive control
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Encoder I/F HIPERFACE DSL Safety sample program

Channel Port Name Pin Header | Input/Output Voltage Description
Domain
HFDSL7 ENCIFDIO7 (dsl_in) CN3 #8 Input VDD1833_3 | Data input
ENCIFDOOQ7 (dsl_out) CN3 #6 Output VDD1833 3 | Data output
ENCIFOEQ7 (dsl_en) CN3 #4 Output VDD1833_3 | Drive/receive control
HFDSLS8 ENCIFDIO8 (dsl_in) CN3 #17 Input VDD33 Data input
ENCIFDOOQS8 (dsl_out) CN3 #15 Output VDD33 Data output
ENCIFOEOQS8 (dsl_en) CN3 #13 Output VDD33 Drive/receive control
HFDSL9 ENCIFDIO9 (dsl_in) CN3 #18 Input VDD1833_2 | Data input
ENCIFDOQ9 (dsl_out) CN3 #16 Output VDD1833_2 | Data output
ENCIFOEQ9 (dsl_en) CN3 #14 Output VDD1833_2 | Drive/receive control
HFDSL10 | ENCIFDI10 (dsl_in) CN3 #27 Input VDD1833_2 | Data input
ENCIFDO10 (dsl_out) CN3 #25 Output VDD1833 2 | Data output
ENCIFOE10 (dsl_en) CN3 #23 Output VDD1833_2 | Drive/receive control
HFDSL11 | ENCIFDI11 (dsl_in) CN3 #26 Input VDD1833_2 | Data input
ENCIFDO11 (dsl_out) CN3 #24 Output VDD1833_2 | Data output
ENCIFOE11 (dsl_en) CN3 #22 Output VDD1833_2 | Drive/receive control
HFDSL12 | ENCIFDI12 (dsl_in) CN10 #9 Input VDD1833_6 | Data input
ENCIFDO12 (dsl_out) CN10 #7 Output VDD1833_6 | Data output
ENCIFOE12 (dsl_en) CN10 #5 Output VDD1833_6 | Drive/receive control
HFDSL13 | ENCIFDI13 (dsl_in) CN10 #8 Input VDD1833_6 | Data input
ENCIFDO13 (dsl_out) CN10 #6 Output VDD1833_6 | Data output
ENCIFOE13 (dsl_en) CN10#4 Output VDD1833_6 | Drive/receive control
HFDSL14 | ENCIFDI14 (dsl_in) CN10 #17 Input VDD33 Data input
ENCIFDO14 (dsl_out) CN10 #15 Output VDD33 Data output
ENCIFOE14 (dsl_en) CN10 #13 Output VDD33 Drive/receive control
HFDSL15 | ENCIFDI15 (dsl_in) CN10 #18 Input VDD33 Data input
ENCIFDO15 (dsl_out) CN10 #16 Output VDD33 Data output
ENCIFOE15 (dsl_en) CN10 #14 Output VDD33 Drive/receive control
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3.3 Procedures on Development Environments: CR52 ver.

3.3.1 Preparation before Executing the Sample Program

This sample program communicates with a PC. The USB connection terminal on the target board is CN34.
Select higher-numbered port from COM ports that appear at connecting the board with the host PC.
The terminal software of the host PC is set as shown in the following table.

Function Setting
Communication method Asynchronous serial transmission/reception
Sending / receiving order LSB first
Transfer rate 19200 bps
Character length 8 bits
Stop bit length 1 bit
Parity function None
Hardware flow control None

3.3.2 EWARM from IAR Systems
(1) Build Environment

IAR Embedded Workbench for ARM (EWARM)

Version 9.60.2 + patch (EWARM_Patch_for RZT2H N2H_ rev1.0)
RENESAS FSP Smart Configurator (FSP SC) 2024-10
RENESAS Flexible Software Package (FSP) for RZ/T2 v2.2.0

(2) Execution Environment ICE
IAR I-jet

(3) Build Procedure of the Sample Program
The build procedure for the sample program is as follows.

1 Copy the extracted source files to the desired location.

Activate EWARM.

Select [File] menu -> [Open Workspace].

Open the extracted source file RZ_T2H_hfdsl.eww.

Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE. *

a b wODN

Note: The following procedure adds the activation of the FSP Smart Configurator to the [Tools] menu of the
EWARM IDE. Select [Tools] menu -> [Tool Configuration] in the EWARM IDE. Select the [New]
button, specify a table string in each field, and press [OK].

Field String
Menu text FSP Smart Configurator
Command $RASC_EXE_PATHS
Argument --compiler IAR configuration.xml
Initial directory $PROJ_DIR$

String for the command is variable holding the path of the Smart Configurator execution file, rasc.exe.

You can also start the FSP Smart Configurator directly from the command prompt by specifying the
folder where it is installed.
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6 Inthe FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rzt,
rzt_cfg, rzt_gen, script and .setting folders will be generated.

m C¥1_Prog¥Work¥Work_C¥Work_EWA_960_2_fsp2.2.0¥RZT2H_HFDSL_Safety_release_chk - FSP Smart Configurator — [m] X |
File Window Run Help
H_HFDSL_Safety_release_chk] FSP Configuration “% FSP Visualization =0
0

Summary Generate Project Content &

Project Summary ~

RENESAS

Board: RZT2H Evaluation Board (RAM execution without flash memory)

Device: ROA09GO7TM44GBG

Core: CR52 CPUO

FSP Version: 220
Project Type: Flat

Location: C:/1_Prog/Work/Work_C/Work_EWA_96 __0/RZT2H_HFDSL_Safety release_chk
Sel d software comp s
Board support package for ROADSGO7TM44GBG v220
Board support package for RZT2H v220
Board support package for RZT2H - FSP Data v220 i

Properties |2 Problems ul = 8 Econsole - v =F

No consoles to display at this time.

7 When project generation is complete, close the Smart Configurator.
8 Select [Rebuild All] from the [Project] menu of EWARM.
The file Debug\Exe\RZ_T2H_hfdsl.out is generated.

(4) Execution Procedure of the Sample Program

After executing the "build procedure”, connect the target board and debugger correctly, and perform the
following operations.

1 Select [Project] menu -> [Download and Debug].
2 Select [Debug] menu -> [Execute].

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see 4.11.6
console commands in the RZ/T2H Group HIPERFACE DSL Safety Sample Program Application Note.
¥ COM10 - Tera Term VT - [m] X

JrALF) BEE) BES VMOS0 2UEIW) ALTH)
fet o a
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3.3.3 e? studio from RENESAS
(1) Build Environment

RENESAS e? studio 2024-10
Toolchain version: GNU ARM Embedded 12.2.1.arm-12-24
RENESAS RZ/T2 Flexible Software Package v1.3.0-t2h.alpha.2

(2) Execution Environment ICE
SEGGER J-Link v7.98c

(3) Build Procedure of the Sample Program
The procedure for building the sample program is as follows.

1 Copy the expanded source file to any location.

2 After launching e? studio and moving to the workspace, click the [File] menu-> [Import] and select
Existing project to workspace and click [Next].

3 On the project import screen, select the folder where the sample program was expanded as the root
directory.

4 Select a project, check Copy Project to Workspace, and click [Finish].

5 Double-click the configuration.xml in the Project Explorer pane of e? studio to open it.

Q RZT2H_HFDSL_Safety_release_chk - e* studio i [m] ¥
File Edit Source Refactor Mavigate Search Project RenesasViews Run Renesas Al Window Help

‘_é_vfgv e it Q [ :_L‘.C}C++
{1 Project Explorer =0 = 0O | % outline X =M1 .

= : There is no active editor ca

+ |5 RZ_T2H_hfdsl [Debu that provides an outline,

nit Includes

-

127 configuration.xml|
1 sl Debug_Hatjlink
¥ RZ_T2H_hfdsl Debug_Flatlaum
7) Developer Assistance
2! problems * [ Console| (] Properties @& Smart Browser &) Smart Manual §d =0
0 errors, 12 warnings, 0 others
Description Resource Path Location Type
I, Warnings (12 items)

52 configurationxml - RZ_T2H_hfdsl
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6 Click Generate Project Content in the FSP Configuration pane of e? studio.
The rzt, rzt_cfg, rzt_gen, script, .settings folders are generated.

) RZT2H_HFDSL _Safety_release_chk - RZ_T2H_hfdsl/configuration.xm! - € studio - O b
File Edit Source Refactor Navigate Search Project Renesas\Views Run RenesasAl Window Help
S - & - o iter Q- Q Gec/ces
{3 Project Explorer > =0 [RZ_T2H_hfdsl] FSP Configuration X 25 Outline X =0
= Summar L) There is no active editor that provides €
“ I~ RZ_T2H_hfdsl Y Generate Project Content an outline.
&) Includes )
e Project Summary A
E RENESAS
» configurationxmi ' M t fl
2 o S
RZ.T2H_hfdsl Debug_Flatjlink g:alrd. ;s;g:@E;;iatmG\:Guavd (RAM execution without flash memory)
vice: 144
X| RZ_T2H_hfdsl Debug_Flatlaunch
% Delopir A<'Stan(-t Core: CR52 CPUO
IR Toolchain: GCC for Renesas RZ
Toolchain Version: 12.2.1.am-12-24
FSP Version: 220
Project Type: Flat
Location: C:1_Prog/Work/Work_C/Work_E2S_RZ..L_Safety_release_chk/RZ_T2H_nfdsi -
Selected software components
Board support package for ROAD9GO77TM44GBG v220
Board support package for RZT2H v2.20
Board support package for RZT2H - FSP Data v2.20 by
Summary | BSP| Clocks | Pins| Intermupts | Event Links | Stacks| Components
*| Problems > | B Console Properties | @ Smart Browser ) Smart Manual ===
0 errors, 12 wamings, 0 others
Description Resource Path Location Type
1 Warnings (12 items)
configurationxml - RZ_T2H_hids!

7 Select [Project] menu -> [Build All].
The Debug\RZ_T2H_hfdsl.elf file is generated.

(4) Execution Procedure of the Sample Program

After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging].
2 Click [Debug] to start downloading to internal RAM.
3 Click [Run] menu -> [Resume] to run the sample program.

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see 4.11.6
console commands in the RZ/T2H Group HIPERFACE DSL Safety Sample Program Application Note.
¥ COM10 - Tera Term VT - [m] x

IriL(F) E|E(E) IYRO-IW0)  HUESW) ALTH)

rt ~
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3.4 Procedures on Development Environments: CA55 ver.

3.4.1 Preparation before Executing the Sample Program

This sample program communicates with a PC. The USB connection terminal on the target board is CN34.
Select lower-numbered port from COM ports that appear at connecting the board with the host PC.
The terminal software of the host PC is set as shown in the following table.

Function Setting
Communication method Asynchronous serial transmission/reception
Sending / receiving order LSB first
Transfer rate 19200 bps
Character length 8 bits
Stop bit length 1 bit
Parity function None
Hardware flow control None

3.4.2 EWARM from IAR Systems
(1) Build Environment

IAR Embedded Workbench for ARM (EWARM)

Version 9.60.2 + patch (EWARM_Patch_for RZT2H N2H rev1.0)
RENESAS FSP Smart Configurator (FSP SC) 2024-10
RENESAS Flexible Software Package (FSP) for RZ/T2 v2.2.0

(2) Execution Environment ICE
IAR I-jet

(3) Build Procedure of the Sample Program
The build procedure for the sample program is as follows.

1 Extract RZ_T2H_CA55_hfdsl.zip and copy the extracted source files to the desired location.
Activate EWARM.

Select [File] menu -> [Open Workspace].

Open the extracted source file RZ_ T2H _CR52_0 _primary -> RZ_T2H_CR52_0_primary.eww.
Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE. *

a b wWwN

Note: The following procedure adds the activation of the FSP Smart Configurator to the [Tools] menu of the
EWARM IDE. Select [Tools] menu -> [Tool Configuration] in the EWARM IDE. Select the [New]
button, specify a table string in each field, and press [OK].

Field String
Menu text FSP Smart Configurator
Command $RASC_EXE_PATHS
Argument --compiler IAR configuration.xml
Initial directory $PROJ_DIR$

String for the command is variable holding the path of the Smart Configurator execution file, rasc.exe.

You can also start the FSP Smart Configurator directly from the command prompt by specifying the
folder where it is installed.

R11ANO810EJ0201 Rev.2.01
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6 Inthe FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rzt,
rzt_cfg, rzt_gen, script and .setting folders will be generated.

TG C:¥1_Prog¥WorkéWork C¥Work EWA 960 2 fsp2.2.0¥RZT2H_HFDSL_Safety CASS release chk¥RZ_T2H_CRS2_0_primary - FSP Smart Configurator

{E) X ‘
File Window Run Help
&% [RZ_T2H_CRS2_0_primary] FSP Configuration m— 45 (5P Vis i =
o ) »
Summary Generate Project Content l E -
Project Summai A
d v RENESAS 200000000000000000000000005
Board: RZT2H Evaluation Board (RAM execution without flash memory)
Device: ROA09G0O77TM44GBG
Core: CR52 CPUO

FSP Version: 220
Project Type: Flat
Location: C./1_Prog/Work/Work_C/Work_EWA_96...release_chk/RZ_T2H_CR52_0_primary =

Selected software components

Board support package for ROADSGO7TM44GBG v220
Board support package for RZT2H v220
Board support package for RZT2H - FSP Data v220 &
ol (-
Support ik =
Summary | BSP| Clocks | P terrupts | Event Links | Stacks | Companent » A
[ properties [£] Problems N E § = 8 B console =08
Property Value No consoles to display at this time.

7 When project generation is complete, close the Smart Configurator.
8 Select [Rebuild All] from the [Project] menu of EWARM.
The file Debug\Exe\RZ_T2H_CR52_0_primary.sbd is generated.
9 Select [File] menu -> [Open Workspace].
10 Open the extracted source file RZ_T2H_CAS55_0_hfdsl -> RZ_T2H_CA55_0_hfdsl.eww.

(RZ_T2H_CR52_0_primary.sbd of the primary project is referenced to open this workspace file.
Please build the primary project in advance.)

11 Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE.

12 In the FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rzt,
rzt_cfg, rzt_gen, script and .setting folders will be generated.

G C:¥1_Prog¥workiWork_C¥Work_EWA_960_2 fsp2.2.04RZT2H_HFDSL_Safety CASS_release_chk¥RZ_T2H_CASS_0_hfdsl - FSP Smart Configurator - o x ‘

File Window Run Help

5% [RZ_T2H_CA55_0

|_hfdsl] FSP Configuration X

5 FSP Visualization =1

Summary o | =)

Generate Project Content

Project Summary RENESAS &

Board: RZT2H Evaluation Board (RAM execution without flash memory)

Device: ROADIGO77TM44GBG

Core: CAS5 Core0

FSP Version: 220

Project Type: Flat

Location: C:M_Prog/Work/Work_C/Work_EWA_96_.5_release_chk/RZ_T2H_CA55_0_hfdsl <=

Encoder I/F HIPERFACE DSL Safety sample program

Selected software components

Board support package for ROADSGO77M44GBG
Board support package for RZT2H
Board support package for RZT2H - FSP Data

Summary | BSP| Clocks| P

=] Properties [8 Problems

Properties are not available.

v220
v220
v220 ]

[3333TTILL
ITITTIIIIT
VPP IPP RO

™ § =08 B console [~ =0

No consoles to display at this time.

13 When project generation is complete, close the Smart Configurator.
14 Select [Rebuild ALL] from the [Project] menu of EWARM.
The file Debug\Exe\ RZ_T2H_CAS55_0_hfdsl.out is generated.
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RZ/T2H Group Encoder I/F HIPERFACE DSL Safety sample program

(4) Execution Procedure of the Sample Program

After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Inthe workspace of RZ_T2H_CR52_0_primary, select [Project] menu -> [Download and Debug].
RZ_T2H_CA55_0_hfdsl project is launched.

2 Inthe workspace of RZ_T2H_CR52_0_primary, select [Debug] menu -> [Execute]. CA55 start-up
program is executed.

3 Inthe workspace of RZ_T2H_CA55 0_hfdsl, select [Debug] menu -> [Execute]. Sample program is
executed.

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see 4.11.6
console commands in the RZ/T2H Group HIPERFACE DSL Safety Sample Program Application Note.

" COMS - Tera Term VT - ] X
JrAILF) RE(E) (S JYPO-JLO)  HUEIW) ALTH)
art

3.4.3 e? studio from RENESAS
(1) Build Environment

RENESAS e? studio 2024-10
Toolchain version:
GNU ARM Embedded 12.2.1.arm-12-24 (Used by RZ_T2H_CR52_0_primary)
GCC ARM A-Profile (AArch64 bare-metal) 10.3.1.20210621 (Used by RZ_T2H_CA55_0_hfdsl)
RENESAS Flexible Software Package (FSP) for RZ/T2 v2.2.0

(2) Execution Environment ICE
SEGGER J-Link v7.98c

(3) Build Procedure of the Sample Program
The procedure for building the sample program is as follows.

1 Extract RZ_T2H_CA55_hfdsl.zip and copy the expanded source file to any location.

2 After launching e? studio and moving to the workspace, click the [File] menu-> [Import] and select
Existing project to workspace and click [Next].

3 On the project import screen, select the folder where the sample program was expanded as the root
directory.

4 Select a project, check Copy Project to Workspace, and click [Finish].
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RZ/T2H Group Encoder I/F HIPERFACE DSL Safety sample program

5 Double-click the configuration.xml of the RZ_T2H_CR52_0_primary project in the Project Explorer

pane of e? studio to open it.

a RZT2H_HFDSL Safety CASS release_chk - &” studio

8
&

~ |5 RZ_T2H_CAS55_0_hfds!

y Includes

provides an outline.

=

& src

19 configurationxmi

RZ_T2H_CAS55_0_hfdsl Debug_Flat,lir

RZ_T2H_CAS55_0_hfdsl Debug_Flatlau
(7) Developer Assistance

~ |5 RZ_T2H_CR52_0_primary [Debug

) Includes
e

RZ_T2H_CR52_0_pnmary Debug_Flat,
X| RZ_T2H_CR52_0_prnimary Debug_Flat.
(@) Developer Assistance

£

. Problems % | B Console [Z] Properties| @ Smart Browser L5 Smart Manual R
0 errors, 24 wamings, 0 others

Description Resource Path Location Type
b Wamings (24 items)

15 configurationxml - RZ_T2H_CR52_0_primary

6 Click Generate Project Content in the FSP Configuration pane of e2 studio.

There is no active editor that

ol

— O
File Edit Source Refactor Navigate Search Project RenesasViews Run Renesas Al Window Help
D~-K- it Q- Q E|oces
I¢ Project Explorer X S8 = 0O | B Outline X =0

3
les)

The rzt, rzt_cfg, rzt_gen, script, .settings folders are generated in the RZ_T2H_CR52_0_primary

i)

3
<)

Q RZT2H_HFDSL_Safety CASS release_chk - RZ_T2H_CR52_0_primary/cenfiguration.xml - & studio - [m]
File Edit Source Refactor Navigate Search Project RenesasViews Run RenesasAl Window Help
B4 - il Q- Q B Eoce
{1 Project Explorer X | = & § = O ||} [RZ_T2H_CRS2_0_primary] FSP Configuration X T)EE Outiine X | = O
v |5 RZ_T2H_CAS5_0_hfds! S o There is no active editor
#) Includes Generate Project Content  §l that provides an outline.
8 src -
{8 configurationxmi Project Summary - — A
RZ_T2H_CAS5_0_hfdsl Debug_Flatjlink
%) RZ_T2H_CAS5_0 hidsl Debug_Flatiaunch | BOard: RZT2H Evaluation Board (RAM execution without flash memory)
Device: ROADIGOTTMA4GBG
) Developer Assistance
v &5 RZ_T2H_CRS2.0_primary [Debu Sore: SRz orn
s Toolchain: GCC for Renesas RZ
xt e Toolchain Version: 12.2.1.arm-12-24
R FSP Version: 220
B RLT2H.CRS20 prmary Deg gk | YW TP Pl
e Lae S prmany ebug TAGNIE | Location: C:1_Prog/WorkWork_C/Work_E2S_RZ _release_chiRZ_T2H_CR52_0_primary =5
%) RZ_T2H_CRS2_0_primary Debug_Flatlaun - - - - -0 -
7) Developer Assistance Selected software components
Board support package for ROA09GO77TM44GBG v2.20
Board support package for RZT2H v220
Board support package for RZT2H - FSP Data v220 o
DI
Support &
Summary | BSP, Clocks Pins | Interrupts, Event Links| Stacks| Components
*/ Problems | [E) Console [T] Properties| @ Smart Browser K} Smart Manual §i=m
0 errors, 24 wamnings, 0 others
Description Resource Path Location Type
5 Warnings (24 items)
< >
5% configurationxml - RZ_T2H_CRS2_0_primary

7 Select RZ_T2H_CR52_primary project in the Project Explorer pane and execute [Run] menu -> [Build

Project].
The file Debug\RZ_T2H_CR52_0_primary.sbd is generated.

8 Double-click the configuration.xml of the RZ_T2H_CA55_0_hfdsl project in the Project Explorer pane
of €2 studio to open it. (RZ_T2H_CR52_0_primary.sbd of the primary project is referenced to open this

configuration file. Please build the primary project in advance.)

R11ANO810EJ0201 Rev.2.01
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RZ/T2H Group

Encoder I/F HIPERFACE DSL Safety sample program

9 Click Generate Project Content in the FSP Configuration pane of e2 studio.
The rzt, rzt_cfg, rzt_gen, script, .settings folders are generated in the RZ_T2H_CA55 0_hfdsl project.

8 RZT2H_HFDSL_Safety_CASS_release_chk - RZ_T2H_CAS5_0_hfdsl/configuration.am - € studio

File Edit Source Refactor Navigate Search Project RenesasViews Run Renesas Al Window Help

Includes

@ src
Project Summary

CDT Build Console [RZ_T2H_CAS5._0_hfdsl]

< >

w configurationxml - RZ T2H_CA55 0_hfdsl

10 Select [Project] menu -> [Build All].
The Debug\RZ_T2H_CA55_0_hfdsl.elf file is generated.

(4)

Execution Procedure of the Sample Program

LR il v Q-
C3 Project Explorer X | =) & § = O || {} [RZ_T2H_CR52.0_primary] FSP Configuration | {0} [RZ_T2H_CASS_0_hfdsl] FSP Configuration
c i
v g5 RZ_T2H_CAS5_0_hfdsl [Debug
i e Summary

Generate Project Content

& ; A
12 configuration.xml ReEnESAS
RZ_T2H_CAS5_0_hfdsl Debug_Flatjlink
% RZ_T2H_CASS 0. hidsl Debug_Flatlaunch Board: RZT2H Evaluation Board (RAM execution without flash memory)
%) D Device: ROADIGOTTMA4GBG
eveloper Assistance
v &5 RZ_T2H_CRS2.0_primary Sore: SRS Cioew)

& Binaries Toolchain: GCC for Renesas RZ (A-Profile AArch64 bare-metal)

= Toolchain Version: 103 120210621

#)! Includes 5

S ot FSP Version: 220

e £ Project Type: Flat

i en 3

2 =g Location: C:M_Prog/Work/Work_C/Work_E25_RZ...5_release_chk/RZ_T2H_CAS55_0_hfdsl ==

@ src

& Debug Selected software components

& rztcfg

& script Board support package for ROADIGO77TM44GBG v2.20
18 configurationxml Board support package for RZT2H V220

RZ_T2H_CR52_0_primary Debug_Flat jlink Board support package for RZT2H - FSP Data v22.0 ™

%) RZ_T2H_CRS52.0_primary Debug Flatlaun e

7) Developer Assistance @ X

Support [} =
Summary | BSP| Clocks Pins| Interrupts | Event Links | Stacks| Components
] problems ) Console X | [Tl Properties| @ Smart Browser L} Smart Manual x® IS

- [m] X |
Q E|fEcce
B Outline X S

There is no active editor &%)
that provides an outiine.

~B-<-=0

After executing the "build procedure", connect the target board and debugger correctly, and perform the

following operations.

1 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging] for the
RZ _T2H _CR52_0_primary project.
Click [Debug] to start downloading to internal RAM.
2  Click [Run] menu -> [Resume] to run the CA55 start-up program.
3 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging] for the
RZ_T2H_CA55 0_hfdsl project.
4 Select 'No' when the dialog box inquiring about termination of the active debug session is displayed.
& Launcher x
l A Renesas GDB debug session is already active.
o Do you want to terminate all currently active debug sessions before starting the new
session? (Note: Selecting No may result in unstable debug functionality)
[[] Remember my decision
es | Mo Cancel
5 If 'Proceed with launch' is displayed, select 'Yes'.

6 Click [Debug] to start downloading to internal RAM.

7 Click [Run] menu -> [Resume] to run the sample program.

R11ANO810EJ0201
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RZ/T2H Group Encoder I/F HIPERFACE DSL Safety sample program

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see 4.11.6
console commands in the RZ/T2H Group HIPERFACE DSL Safety Sample Program Application Note.

[ COMS - Tera Term VT - O X
E(S)  IVRO-IMQ)  uEawW) ALTH)
start

IriL(F) E|E(E)
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RZ/T2H Group Encoder I/F HIPERFACE DSL Safety sample program

Revision History

Description
Rev. Date Page Summary
0.50 Oct 31.23 - First Edition issued
0.60 Apr 26.24 2-4 Update the application note and release note version number.

Update sample program version to 0.6 (Support FSP v1.3.0.)
Update file structure. Add structure of CA55 version.

5 Update memory size information. Add information of CAS55 ver.
1,6 Update description of the board name.
8-11 Update build environment and figures for CR52 ver.
12-16 Add development procedures for CA55 ver.
2.00 Nov 21.24 2-4 Update revisions of the application note and the release note.

Update sample program version to 2.0. (Support short
message. Support FSP v2.2.0.)
Update the file structure.

5 Update memory size information.
6 Add SW14 in setting of target board.
8-17 Update build environment for FSP v2.2.0. Figures are
replaced.
2.01 Dec 13.24 2,3 Update revision of the release note.

Correct path name of the FSP SC in the sample program
environment files to use default installation path.
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LS| are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an I/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between V.
(Max.) and Vi1 (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between Vi (Max.) and Vix (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.



Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of
your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the
use of these circuits, software, or information.

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.

3. Nolicense, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for

each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas
Electronics disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas
Electronics product that is inconsistent with any Renesas Electronics data sheet, user’'s manual or other Renesas Electronics document.

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc.
Renesas Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products
outside of such specified ranges.

9. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you
are responsible for evaluating the safety of the final products or systems manufactured by you.

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

12. ltis the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.
(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1  October 2020)

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan

www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

Contact information

For further information on a product, technology, the most up-to-date
version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/.
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